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1. PROBLEM SOLVING PROCESS

When you cannot properly use your computer or there is something wrong with operations,
follow the trouble solving process below to solve problems.

YES

NO

Check with the online manual.

You can view the instructions to use
your computer and solve problems
on your computer’s LCD.
You can also enter a keyword to
search information.

Check with the FAQ
in this manual.

The FAQ provides frequently asked
questions about the computer and
answers to the questions that are
classified into categories, such as
“Turning on/off”.

Check the state of
your computer.

• Can you use the
Accupoint II or
keyboard?

• Does the LCD display
anything?

• Can you turn on your
computer?
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Contact the support personnel
for the application.

See “4-3 Support information” in
Chapter 7.

Contact “Toshiba PC Dial”.

Check “Trouble Checklist” provided
at the end of this manual before
making a phone call.

Check with
“dynabook.com”.

Connect to the Internet
and view the information
on the home page
“dyanabook.com”.
This website provides the
latest information on the
computers, frequently
asked questions, and
technical information.

Application
troubles

Computer troubles

For the support information, including information about troubles and repair of your computer,
see “Toshiba PC Support Information” that comes with your computer.
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Support Information

URL http://dynabook.com/assistpc/index_i.htm
Click the [Support Information] tab on the “dynabook.com” top page (http://dyanbook.com/) to
see the information.

The support information page provides frequently asked questions (FAQ), the download service
of device drivers and updated modules, and Windows-related information.
It also provides user registration through the Internet and information about the support windows
and repair.

Assistance in Computer Operations, “Frequently Asked Questions (FAQ)”

URL http://www5.toshiba.co.jp/pcss/member/techinfo/dial/index_i.htm
Click the [Support Information] tab on the “dynabook.com” top page (http://dyanbook.com/) (1)
and click the [Frequently Asked Questions] button (2) to see the frequently asked questions and
answers to them.

(1)

(2)
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The support staff posts answers with figures and explanations to the frequently asked questions.
You can search information with a keyword or a text.

“dyanbook.com” is subject to change in order to provide the latest information.
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1. Before Viewing FAQ
Opening the Control Panel

The Control Panel is a folder that you need to open in order to change or view the computer
settings.

1. Click [Start] (1) → [Control Panel] (2).

The following shows a sample image of Windows XP Home Edition.

(1)

(2)
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[Control Panel] Window

The [Control Panel] window has two appearances: one with categories only and the other with
all the options (icons).
The following describes how to select each appearance.
* This manual uses the appearance with categories to describe operations.

Click an icon or an underlined
section to display its category
menu.

Windows that show all the options (Classic display)

Double-click an icon to display
its optional window.

Click the underlined
section to select the
display type.

Windows that show categories only:
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Closing the [Control Panel] Window

The following describes how to close the optional windows and the [Control Panel] window
after setting or viewing information.

1. Close the optional window.

The method to close the window varies depending on whether to activate the settings that
you changed.

Click here to close the window.
Any changes to the settings will
be discarded unless the [Apply]
button has been clicked.

Click here to apply the settings.
The window will close.

Click here to close the window.
Any changes to the settings will be discarded
unless the [Apply] button has been clicked.

Click here to apply the settings and close the window.
If the settings have already applied, the [Close] button
may appear instead of the [OK] button.

If multiple windows are opened in the course of setting, the previous window is activated when
you close one window.
When you close all optional windows, the [Control Panel] window is activated.

TIP: • Clicking the [Cancel] or [Close] button (  ) following the [Apply] button does not
discard the changed settings.

2. Click the [Close] button (  ) on the [Control Panel] window.

The [Control Panel] window closes.
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2. Q & A
Turning on/off

Q The power switch does not work.  .......................................................................... 64
Q My computer initiates start-up but fails.  ................................................................. 64
Q My computer automatically turns on.  ..................................................................... 65
Q Selecting [Turn Off Computer] does not turn off my computer.  ............................... 65
Q My computer abruptly turns off.  ............................................................................ 66
Q My computer turns off when it is not used for a while.  ............................................ 66
Q I have shut off the power to my computer by mistake.  ............................................. 67

LCD/External Display

Q Nothing appears on the LCD.  ................................................................................ 68
Q The LCD shows unclear images.  ........................................................................... 69
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Q The colors on the LCD are not clear.  ..................................................................... 69
Q The colors on the external display blur.  .................................................................. 70

Windows

Q The system clock is not correct.  ............................................................................. 71
Q The processing speed of my computer slowed.  ....................................................... 71

Battery Power Operations

Q The Battery LED lights.  ........................................................................................ 73
Q The Battery LED flashes in orange even

when the fully charged battery pack is used.  ........................................................... 73
Q During battery power operations, my computer turns off

if it is not used for a while.  .................................................................................... 73

Keyboard

Q I cannot input a character by pressing the respective key.  ........................................ 75
Q I cannot input the back slash “\”.  ........................................................................... 75
Q I cannot input HIRAGANA and KANJI characters.  ................................................ 75
Q I want to change the input mode using the keyboard.  .............................................. 75
Q I cannot input symbols and special characters.  ........................................................ 76
Q A character that is not printed on the key top is input.  ............................................. 76
Q No keys respond. The keyboard settings are correct but

I cannot input desired characters.  ........................................................................... 77
Q I spilled my drink on the keyboard.  ........................................................................ 78

Accupoint II/Mouse

Q The pointer does not move in response to the Accupoint II or mouse movement.  ...... 79
Q I cannot double-click.  ........................................................................................... 79
Q The pointer speed is slow/fast.  ............................................................................... 79
Q I cannot use the USB mouse.  ................................................................................. 80
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Sound Feature

Q I do not hear any sounds from the speaker.  ............................................................. 81
Q I hear a high-pitched noise.  ................................................................................... 82
Q I hear sound skips during playback.  ....................................................................... 82

LAN Feature

Q I cannot connect to a network.  ............................................................................... 83

Optional Devices

Q Do I need to turn on my computer and the connected optional devices
in a certain order?  ................................................................................................. 85

Q The connected optional device does not successfully work.  ..................................... 85

PC Card

Q The PC card is not detected.  .................................................................................. 86
Q The PC card is detected but not as a device.  ........................................................... 86
Q The PC card is detected but I cannot use it.  ............................................................ 86

SD Memory Card

Q I cannot use the SD memory card.  ......................................................................... 87
Q I cannot write (save data) onto the SD memory card.  .............................................. 87
Q I cannot play back songs stored in the SD memory card.  ......................................... 87
Q “READ ERROR”, “DATA ERROR”, or “CODE ERROR” is displayed.  ................. 87

USB-compatible Devices

Q I cannot use the USB-compatible device.  ............................................................... 88
Q The USB-compatible device does not successfully work

when my computer resumes from Hibernate mode.  ................................................. 88

Application

Q I cannot use an application.  ................................................................................... 89
Q An application freezes  . ......................................................................................... 89
Q I deleted the preinstalled application by mistake.  .................................................... 89

Messages

Q “Password =” is displayed.  .................................................................................... 90
Q “The input password is not correct.” is displayed.  ................................................... 90
Q “Previous resume from hibernate failed. Would you like to tray again

[Enter = Y, Esc = N]?” is displayed.  ...................................................................... 90
Q The following messages are displayed.  .................................................................. 90
Q “C:¥>_” is displayed.  ............................................................................................ 91
Q Other messages are displayed.  ............................................................................... 91
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Others

Q My computer starts in Safe Mode.  ......................................................................... 92
Q My computer makes rattling noises.  ....................................................................... 92
Q I hear TV and radio sounds.  .................................................................................. 92
Q The TV and the radio nearby my computer do not work properly.  ............................ 93
Q My computer freezes.  ........................................................................................... 93
Q My computer may have been infected by a computer virus.  ..................................... 93
Q I noticed an abnormal smell and heat.  .................................................................... 94
Q I cannot figure out the cause of inoperability.  ......................................................... 94
Q I want to dispose of my computer.  ......................................................................... 94
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? TURNING ON/OFF

Q The power switch does not work.

A If you press and release the power switch too quickly, your computer may not be turned on.
Press the power switch until the Power  LED lights in green.

Q My computer initiates start-up but fails.
(The Battery  LED flashes in orange.)

A The battery pack may not be sufficiently charged.
Take either of the following actions:

• Connect the AC adapter supplied with your computer.
Do not use any third-party AC adapter.

• Replace the battery pack with a fully charged one.

REFERENCE: For more information on the battery pack, see “1 Use of the battery pack” in
Chapter 4.

(The DC IN  LED flashes in orange.)

A The power supply system may not be properly connected.
Connect the battery pack and the AC adapter properly.

REFERENCE: For more information on inserting/removing the battery pack, see “1-3
Replacing the battery pack” in Chapter 4.

A The protective function may have been activated.
Do the following:

• Move your computer to a cooler place and let your computer cool down.
When the interior temperature of your computer exceeds the predefined temperature,
the protective function is activated to automatically shut down the system.

• Remove any obstacles blocking the air vent.
Blocking the air vent causes the interior temperature of your computer to rise.

If the above actions do not work, contact the nearest maintenance service.
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Q My computer automatically turns on.

A Start-up may be scheduled in the Windows task scheduler.
If [Clear the sleep mode when performing a task] is selected in the task scheduler, the
scheduler automatically wakes up the system from the Standby or Hibernate state to perform
the task.
To change the setting, follow the steps below:

(1) Click [Start] → [All Programs] → [Accessories] → [System Tools] → [Tasks].

(2) Double-click the scheduled task.
Use the time that your computer turned on as a clue to select the task.

(3) Uncheck [Clear the sleep mode when performing a task] under [Power
management] on the [Settings] tab.

(4) Click the [OK] button.

A The panel switch function may be activated.
To deactivate the panel switch function, follow the steps below:

(1) Open the [Control Panel] window and click [Performance and Maintenance].

(2) Click [Toshiba Power Saving].

(3) Select desired power saving mode on the [Power Settings] tab and click the
[Advanced] button.

(4) Select [No action] for [When the computer is closed] on the [Operations] tab.

(5) Click the [OK] button.

(6) Click the [OK] button on the [Toshiba Power Saving Properties] window.

Q Selecting [Turn Off Computer] does not turn off my computer.

A Press the  Ctrl  +  Alt  +  Del  keys to turn off your computer.

(1) Press the  Ctrl  +  Alt  +  Del  keys.
The [Windows Task Manager] window appears.

(2) Click [Shut down] on the menu bar.
If you cannot use the Accupoint II or mouse, press the  Alt  +  U  keys.

(3) Click [Turn off computer].
If you cannot use the Accupoint II or mouse, press the  U  key.
The program is aborted and your computer turns off.
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A If pressing the  Ctrl  +  Alt  +  Del  keys does not work, press the power switch for at least
five seconds.

Q My computer abruptly turns off.

A When the interior temperature of your computer exceeds the predefined temperature, the
protective function is activated to automatically shut down the system.
If your computer is hot, move your computer to a cooler place and let your computer cool
down.
If the air vent is blocked, the interior temperature of your computer is likely to rise. Remove
any obstacles blocking the air vent.
If the above actions do not work, contact the nearest maintenance service.

Q My computer turns off when it is not used for a while.

A If the Power  LED is lit, the automatic display suspension function may have been
activated. Do not press the power switch. Your computer is powered although the LCD has
gone blank.
Do either of the following:

• Press the  Shift  or  Ctrl  key.

• Move the Accupoint II.

A If the Power   LED is flashing in orange or unlit, your computer may have been
automatically placed on Standby or into Hibernate.
Press the power switch.

To disable the power saving mode, follow the steps below:

(1) Open the [Control Panel] window and click [Performance and Maintenance].

(2) Click [Toshiba Power Saving].

(3) Select desired power saving mode on the [Power Settings] tab and click the
[Advanced] button.

(4) Select [No] for [System Standby] and [System Hibernate] on the [Power Saving]
tab.

(5) Click the [OK] button.

(6) Click the [OK] button on the [Toshiba Power Saving Properties] window.

REFERENCE: For more information on Standby and Hibernate, see “3 Suspending” in
Chapter 2.
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Q I have shut off the power to my computer by mistake.

A To turn off your computer, click [Start] → [Turn Off Computer].
If the power is shut off during the turn-off process (while the Disk  LED is lit), the hard
disk may be damaged. Do the correct turn-off procedure.
If any abnormality is found in computer operations after aborting your computer by an
inappropriate procedure, run the check disk command to inspect the hard disk. If no error is
found by the check disk command, Windows starts. If any error is found, follow the on-
screen instructions to proceed.

REFERENCE: For information on the check disk command, see “Online Manual”.
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? LCD/EXTERNAL DISPLAY

Q Nothing appears on the LCD.
(The Power  LED is unlit or flashing in orange.)

A Your computer is not turned on or on Standby.
Press the power switch.

(The Power  LED is lit.)

A The automatic display suspension function may have been activated.
Do either of the following:

• Press the  Shift  or  Ctrl  key.
• Move the Accupoint II.

TIP: • If an external display is connected, it may take about 10 seconds to turn on the
display but this is not an error.

A The instant security function may have been activated.
Do the following:

If protection with the password is not activated:

Press the  Shift  or  Ctrl  key or move the Accupoint II.

If protection with the password is activated ([Protect with the password] or [Return to the
Welcome to Windows window at restart] is checked on the [Screen Saver] tab of the
[Display Properties] window):

(1) Press the  Shift  or  Ctrl  key or move the Accupoint II.
If multiple users are registered, click a user name.

(2) Enter the Windows log-on password on the password input window and press the
 Enter  key.

REFERENCE: For information on the instant security function, see “3-1 Special function keys
with the  Fn  key” in Chapter 3.

REFERENCE: For information on the Windows log-on password, see “Online Manual”.

A The display device may not be properly set up.
Press the  Fn  +  F5  keys for at least three seconds.
Your computer’s LCD is activated.

REFERENCE: For more information, see “9 External display” in Chapter 3.
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Q The LCD shows unclear images.

A Adjust the angle of the LCD.

Q The LCD is dark.

A Brightness setting of the LCD may be low.
Take either of the following procedures to change the setting.

•  Method 1

• Press the  Fn  +  F7  keys to increase the brightness.
Press the  Fn  +  F6  keys to decrease the brightness.

•  Method 2

(1) Open the [Control Panel] window and click [Performance and Maintenance].

(2) Click [Toshiba Power Saving].

(3) Select desired power saving mode on the [Power Settings] tab and click the
[Advanced] button.

(4) Adjust [Monitor Brightness] on the [Power Saving] tab.

(5) Click the [OK] button.

(6) Click the [OK] button on the [Toshiba Power Saving Properties] window.

If the above procedures do not increase the LCD brightness, the FL tube (the cold cathode
tube) mounted in the LCD for side lighting may have been worn. Check the model of your
computer and contact the nearest maintenance service. A service fee will be charged for the
replacement work.

Q The colors on the LCD are not clear.

A This occurs when a small number is specified for the colors.
To change the setting, follow the steps below:

(1) Open the [Control Panel] window and click [Appearance and Themes].

(2) Click [Display].
The [Display Properties] window appears.

(3) Specify “Maximum (32 bit)” for [Colors] on the [Settings] tab.

(4) Click the [OK] button.

TIP: • “Maximum” may not be available depending on the resolution.
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Q The colors on the external display blur.

A If the external display is located nearby electric devices that generate strong magnetism,
including a TV, an audio device, or a speaker, move the external display away from them.

TIP: • If the building is located near high-voltage electric wires, rough images on the
display may be rectified by relocating your computer.
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? WINDOWS

Q The system clock is not correct.

A Follow the steps below to correct [Date and Time].

(1) Open the [Control Panel] window and click [Date, Time, Language, and Regional
Options].

(2) Click [Change the date and time].
The [Date and Time Properties] window appears.

(3) Click the digit on the digital clock under [Time] on the [Date and Time] tab.
The time is displayed in “hour: minute: second” format. Click the section that you
want to change.

(4) Use the up and down buttons (  ) at the right end of the digital clock to correct
the time.

(5) Click the [OK] button.

A If you leave your computer unused for a long time, the system clock battery wears out.
Connect the AC adapter to your computer and turn on your computer to charge the system
clock battery.

A If the system clock becomes inaccurate in a while after having charged the battery, the
function to charge the system clock battery may be degraded.
Contact the nearest maintenance service.

Q The processing speed of my computer slowed.

A The CPU processing speed may have changed according to the remaining battery capacity
as specified in the “Toshiba Power Saving Utility”. The default power saving mode is [Full
Power] for AC power operations and [Normal] for battery power operations. The processing
speed of your computer is slower during battery power operations as compared to AC power
operations.
You can change the CPU processing speed in the following procedure:

(1) Open the [Control Panel] window and click [Performance and Maintenance].

(2) Click [Toshiba Power Saving].

(3) Select desired power saving mode on the [Power Settings] tab and click the
[Advanced] button.

(4) Specify the processing speed suitable to the remaining battery capacity with the
slider for [CPU Processing Speed] on the [Power Saving] tab.
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(5) Click the [OK] button.

REFERENCE: For more information on the power saving mode, see “2 Power saving” in
Chapter 4.

A The processing speed may have automatically slowed down because the CPU of your
computer became warmer.
Stop using your computer for a while. The CPU cools down and the original processing
speed is restored.

A The processing speed may have slowed down because there was not much free space in the
hard disk.
Remove unnecessary files to increase the free space in the hard disk.
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? BATTERY POWER OPERATIONS

Q The Battery  LED lights.

A There is not much battery capacity left.
Take either of the following actions immediately.

• Connect the AC adapter to your computer to supply power.

• Turn off your computer and replace the battery pack with a fully charged one.

By not taking any action, your computer will be placed into Hibernate and turned off if
Hibernate is enabled.
If Hibernate mode is disabled, your computer will simply be turned off. This may cause loss
of work data. It is recommended to enable Hibernate mode. Hibernate mode is enabled by
default. It is also recommended that you save data on a regular basis.

REFERENCE: For charging the battery, see “1-1 Charging the battery” in Chapter 4.

Q The Battery  LED flashes in orange even when the fully charged
battery pack is used.

A The battery pack gradually discharges power even when it is not used. Charge the battery
pack again.
If the situation remains after having charged the battery pack, the function to charge the
battery pack may be degraded. Replace the battery pack with a new one that is optionally
available. If the situation still remains, you computer may be faulty. Contact the nearest
maintenance service.

REFERENCE: For information on the remaining battery capacity, see “1-2 Monitoring
battery capacity” in Chapter 4.

Q During battery power operations, my computer turns off if it is not used
for a while.

A Your computer is set to be placed on Standby or into Hibernate and stop the system
operations if it is not used for a certain period of time.
Deactivate the setting.

(1) Open the [Control Panel] window and click [Performance and Maintenance].

(2) Click [Toshiba Power Saving].

(3) Select desired power saving mode on the [Power Settings] tab and click the
[Advanced] button.
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(4) Select [No] for [System Standby] and [System Hibernate] on the [Power Saving]
tab.

(5) Click the [OK] button.

(6) Click the [OK] button on the [Toshiba Power Saving Properties] window.
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? KEYBOARD

Q I cannot input a character by pressing the respective key.

A The system processing may still be in progress.
When the pointer looks like a hourglass (  ), the system processing is in progress and
operations of the keyboard and the Accupoint II may be suspended. Wait until the system
processing is complete.

Q I cannot input the back slash “\”.

A You cannot input the back slash “\” in Japanese fonts.
Pressing the  key inputs “¥” that is equivalent to the back slash.

Q I cannot input HIRAGANA and KANJI characters.

A The Japanese input system is not activated.
Press the  Half/Full  key to start the Japanese input system.

Q I want to change the input mode using the keyboard.

A You can use the following shortcut keys to change the input mode.

•  Shift  +  Caps Lock Alphanumeric  keys: Upper-case lock mode

•  Fn  +  F10  keys: Arrow mode

•  Fn  +  F11  keys: Number lock mode

•  Alt  +  KATAKANA/HIRAGANA  keys: ROMAJI input/KANA input mode
selection

REFERENCE: For more information, see “3 Keyboard” in Chapter 3.
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Q I cannot input symbols and special characters.

A Follow the steps below to look for a desired character in the character code table.

(1) Click [Start] → [All Programs] → [Accessories] → [System Tools] → [Character
Code Table].
The [Character Code Table] window appears.

(2) Select [Font], click the character that you want to use in [Character Code Table],
and click the [Select] button.
The selected character appears in the [Character to copy] field.

(3) Click the [Copy] button.

(4) Click [Edit] → [Paste] from the menu bar of the application that is used to open a
document.
The character that you selected in step (2) is inserted in the document. Apply the
font that you selected in step (2) to the character.

A MS-IME is provided with [IME Pad].
You can look for a desired character in this list.

REFERENCE: For more information, see “MS-IME Online Help”.

Q A character that is not printed on the key top is input.

A The keyboard driver may not be properly set.
Follow the steps below to set the driver again.

(1) Open the [Control Panel] window and click [Performance and Maintenance].

(2) Click [System].

(3) Click the [Device Manager] button on the [Hardware] tab.

(4) Double-click [Keyboard].

(5) Double-click the keyboard driver name that appears.
The [Keyboard Properties] window appears.

(6) Click the [Update Driver] button on the [Driver] tab.
The [Hardware Update Wizard] window appears.

(7) Select [Install from the list or a specific location] and click the [Next] button.

(8) Select [Select the driver to install without search] and click the [Next] button.

(9) Uncheck [Display compatible hardware].
The list of [Manufacturers] and [Models] appears.
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(10) Select [(Standard Keyboard)] from [Manufacturers] and [Japanese PS/2 Keyboard
(106/109 key Ctrl + Alphanumeric)] and click the [Next] button.
The [Confirm Device Installation] window appears.

(11) Click the [Yes] button.
The driver is installed and the [Hardware Update Wizard Complete] window
appears.

(12) Click the [Finish] button.

(13) Click the [Close] button on the [Keyboard Properties] window.
The [Update System Settings] window appears and the message “Do you want to
restart your computer now?” is displayed.

(14) Click the [Yes] button.
Your computer restarts.

Q No keys respond.
The keyboard settings are correct but I cannot input desired
characters.

A Follow the steps below to restart your computer with [Turn Off Computer].

(1) Click [Start] → [Turn Off Computer].

(2) Select [Restart].

A If you cannot restart your computer with [Turn Off Computer], press the  Ctrl  +  Alt  +
 Del  keys to restart it. This will erase unsaved work data.

(1) Press the  Ctrl  +  Alt  +  Del  keys.
The [Windows Task Manager] window appears.

(2) Click [Shut Down] on the menu bar.
If you cannot use the Accupoint II or mouse, press the  Alt  +  U  keys.

(3) Click [Restart].
If you cannot use the Accupoint II or mouse, press the  R  key.

A If pressing the  Ctrl  +  Alt  +  Del  keys does not restart your computer, press the power
switch for at least five seconds to turn off your computer. This will discard unsaved work
data.
Wait a few minutes before starting your computer.
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Q I spilled my drink on the keyboard.

A Entry of any liquid inside the keyboard may cause an electric shock, a malfunction of your
computer, or loss of data. When liquid gets inside your computer, turn off your computer,
remove the AC adapter and the battery pack, and immediately ask your dealer or the nearest
maintenance service for inspection.
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? ACCUPOINT II/MOUSE

*Mouse sold separately.

Q The pointer does not move in response to the Accupoint II or mouse
movement.

A The system processing may still be in progress.
When the pointer looks like a hourglass (  ), the system processing is in progress and
operations of the Accupoint II, the mouse, and the keyboard may be suspended. Wait until
the system processing is complete.

A If the mouse is not properly connected to your computer, you cannot use the mouse.
Connect the mouse properly.
For connecting the mouse, see the manual that comes with your mouse.

Q I cannot double-click.

A Follow the steps below to change the double-clicking speed so that you feel comfortable.

(1) Open the [Control Panel] window and click [Printers and Other Hardware].

(2) Click [Mouse].

(3) Drag the [Double-clicking Speed] slider horizontally on the [Button] tab.

(4) Click the [OK] button.

Q The pointer speed is slow/fast.

A Follow the steps below to change the pointer speed.

(1) Open the [Control Panel] window and click [Printers and Other Hardware].

(2) Click [Mouse].

(3) Drag the [Speed] slider horizontally on the [Pointer Options] tab.

(4) Click the [OK] button.

A Check if the internal components of the mouse are dirty.
If the internal components of the mouse are dirty, the mouse movement becomes dull. When
using the mouse, clean the internal components of the mouse.
For cleaning the mouse, see the manual that comes with your mouse.
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Q I cannot use the USB mouse.

A The USB mouse may not be detected as new hardware.
Follow the steps below to run [Add New Hardware Wizard].

(1) Open the [Control Panel] window and click [Printers and Other Hardware].

(2) Click [Add Hardware] under [See Also].
The [Add New Hardware Wizard] starts.

(3) Click the [Next] button.
Follow the on-screen instructions to proceed.
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? SOUND FEATURE

Q I do not hear any sounds from the speaker.

A Remove the headphone from the headphone output terminal.

A Use the volume dial to adjust the volume.

A The speaker may be muted.
Follow the steps below to change the setting.

•  Method 1

• Press the  Fn  +  Esc  keys.

•  Method 2

(1) Open the [Control Panel] window and click [Sounds, Speech, and Audio Devices].

(2) Click [Change the speaker settings].
The [Sound and Audio Device Properties] window appears.

(3) If [Mute] is checked on (  ) the [Volume] tab, uncheck it.

(4) Drag the slider to adjust the volume.

A The standard [Prioritized Device] may have been changed.
Follow the steps below to change the setting.

(1) Open the [Control Panel] window and click [Sounds, Speech, and Audio Devices].

(2) Click [Sounds and Audio Devices].
The [Sounds and Audio Devices Properties] window appears.

(3) Correct [Default Device] for [Sound Playback] on the [Audio] tab.

(4) Click the [OK] button.

A If the above procedures do not change the volume, the standard sound driver may be
corrupted or erased by mistake.
Re-install the sound driver.

REFERENCE: For information on re-installation, see “Re-installing applications” in Chapter
7.
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Q I hear a high-pitched noise.

A Feedback may have been caused between the external microphone and the speaker. Some
applications may cause this phenomenon. In such a case, do the following:

• Adjust the volume with the volume dial.

• Change the settings of the application in use.

• Move the external microphone away from the speaker.

Q I hear sound skips during playback.

A While the hard disk or CD-ROM of the PC card connection type is in operation, an attempt
to play back sounds may cause sound skips.
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? LAN FEATURE

Q I cannot connect to a network.

A The network settings may be incorrect.
Check the following:

• Windows network settings

• Settings for the destination network device (HUB)

• Conditions of the cable

A The LAN feature may be disabled.
Take either of the following procedures to change the settings.

•  Method 1 - Using [Network Device Switch]
(For the model with the wireless LAN feature only)

(1) Click [Start] → [All Programs] → [Network Device Switch] → [Network Device
Switch].

(2) Click the [Network Device Switch] icon on the Notification area and click the
device that you want to use in the menu.
The wired LAN feature is displayed as [Realtek RTL8139/810X Family Fast
Ethernet NIC].
The wireless LAN feature is displayed as [Toshiba Wireless LAN Mini PCI Card].

•  Method 2 - Using [Device Manager]

(1) Open the [Control Panel] and click [Performance and Maintenance].

(2) Click [System].
The [System Properties] window appears.

(3) Click [Device Manager] on the [Hardware] tab.

(4) Double-click [Network Adapters].
The wired LAN feature is displayed as [Realtek RTL8139/810X Family Fast
Ethernet NIC].
The wireless LAN feature is displayed as [Toshiba Wireless LAN Mini PCI Card]
(for the model with the wireless LAN feature only).
Options marked with X ( ) on the left are disabled.
Follow the steps below to change the setting.

(5) Right-click the option that you want to use and click [Enable] in the menu.

(6) Close the [Device Manager] window.

(7) Click the [OK] button on the [System Properties] window.
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•  Method 3 - Using [Toshiba HW Setup]
(For the wired LAN feature only)

(1) Open the [Control Panel] window and click [Printers and Other Hardware].

(2) Click [Toshiba HW Setup].

(3) Check [Use] for [Built-in LAN] on the [LAN] tab.

(4) Click the [OK] button.
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? OPTIONAL DEVICES

For information on optional devices, see the manuals that come with your devices as well.

Q Do I need to turn on my computer and the connected optional devices
in a certain order?

A First turn on the optional devices, then your computer.
You can turn on and use some optional devices, including USB-compatible devices, when
your computer is already running.
For more information, see the manuals that come with your devices.

Q The connected optional device does not successfully work.

A If the optional device is turned off, turn it on.

A The cable may not be properly connected.
Connect the cable properly.

A The connected device may not be detected as new hardware.
Follow the steps below to run [Add New Hardware Wizard].

(1) Open the [Control Panel] window and click [Printers and Other Hardware].

(2) Click [Add Hardware] under [See Also].
The [Add New Hardware Wizard] starts.

(3) Click the [Next] button.
Follow the on-screen instructions to proceed.

A The optional device may not be compatible with the system (OS).
Some optional devices may only be used with a limited number of systems. Check if the
device is compatible with Windows XP.
For more information, see the manual that comes with your device.
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? PC CARD

Q The PC card is not detected.

A Check if the PC card is inserted all the way to the end.

Q The PC card is detected but not as a device.

A Some PC cards may only be used with a limited number of systems.
For more information, see the manual that comes with your PC card.

A Your computer is the Windows model. It does not support use of the PC card from the MS-
DOS command line.

Q The PC card is detected but I cannot use it.

A IRQ may be insufficient.
Follow the steps below to disable unused devices.

(1) Open the [Control Panel] and click [Performance and Maintenance].

(2) Click [System].

(3) Click [Device Manager] on the [Hardware] tab.

(4) Double-click an unused device category.

(5) Right-click an unused device and click [Disable].
The confirmation message is displayed.

(6) Click the [Yes] button.

(7) Close the [Device Manager] window.

(8) Click the [OK] or [Close] button on the [System Properties] window.
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? SD MEMORY CARD

Q I cannot use the SD memory card.

A The SD memory card may not be properly inserted.
Check if the SD memory card is inserted all the way to the end in the correct orientation
(with the labeled side facing up).

Q I cannot write (save data) onto the SD memory card.

A If the write-protect tab on the SD memory card is in the write-protected position, you cannot
write (save data).
Remove the SD memory card and slide the write-protect tab into the write-free position.

A If there is not much free space in the SD memory card, you cannot write (save data).
Do either of the following:

• Delete unnecessary files and folders to increase the free space and retry.
Once files are deleted from the SD memory card, you cannot restore them. Make sure
that files are not necessary before deleting them.

• Use another SD memory card with sufficient free space.

Q I cannot play back songs stored in the SD memory card.

A The SD memory card may not contain songs that can be played back. Check the songs.

A The data you attempt to play back may not be in the file formats compatible with your
computer. Check the file format.

Q “READ ERROR”, “DATA ERROR”, or “CODE ERROR” is displayed.

A An error is detected during file read. The data may be corrupted.
Delete the file.
If the same error is detected frequently, format the SD memory card.
Formatting the SD memory card will erase the information stored in the SD memory card.
Make sure that the information is not necessary before formatting the SD memory card.
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? USB-COMPATIBLE DEVICES

Q I cannot use the USB-compatible device.

A The cable may not be properly connected.
Connect the cable properly.

A The system may not properly detect the USB-compatible device for some reasons. Restart
Windows.

A The driver may not be properly installed.
Follow the steps below to install the driver.

(1) Open the [Control Panel] window and click [Printers and Other Hardware].

(2) Click [Add Hardware] under [See Also].
The [Add New Hardware Wizard] starts.

(3) Click the [Next] button.
Follow the on-screen instructions to proceed.

Q The USB-compatible device does not successfully work when my
computer resumes from Hibernate mode.

A The connected USB-compatible device may not be compatible with Hibernate mode.
Disconnect the USB-compatible device from the USB connector and connect it again.
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? APPLICATIONS

Q I cannot use an application.

A The application may not be properly installed.
See the manual that comes with your application and install it properly.

A The application may not be compatible with the system (OS).
Some applications may be compatible with only a limited number of systems (OS).
For more information, see the manual that comes with your application.

A There may not be sufficient memory.
If the memory capacity is sufficient enough to start the application, you cannot use it. For
the required memory capacity, see the manual that comes with your application.

A Some applications may require change in the system configuration.
See the manual that comes with your application to change the system configuration.

Q An application freezes.

A If the application freezes, follow the steps below to abort it and then restart the application.
You cannot save the data that you were editing before aborting the application.

(1) Press the  Ctrl  +  Alt  +  Del  keys.
The [Windows Task Manager] window appears.

(2) Click the task that shows [No response] on the [Applications] tab.

(3) Click the [Quit Task] button.
The application closes.

Q I deleted the preinstalled application by mistake.

A You can re-install the preinstalled applications and drivers.

REFERENCE: For re-installation, see “4-2 Re-installing applications” in Chapter 7.



90

? MESSAGES

Q “Password =” is displayed.

A The password is registered.
Input the password that was registered with [Toshiba HW Setup] and press the  Enter  key.
If you do not remember the password, use the key floppy disk. If you do not have the key
floppy disk, check the model of your computer and contact the nearest maintenance service.
A request to the maintenance service because of a deleted password requires submission of
your identification and a service fee will be charged.

REFERENCE: See “Chapter 4.3 Passwords” for information about entering the password.

Q “The input password is not correct.” is displayed.

A You may have input the password in the wrong case because the input mode was
inappropriate.
Press the  Shift  +  Caps Lock Alphanumeric  keys to select the appropriate input mode and
input the password again.

Q “Previous resume from hibernate failed. Would you like to tray again
[Enter = Y, Esc = N]?” is displayed.

A Hibernate mode is disabled.
You cannot restore the previous state of your computer once you turn off your computer.
Press the  Enter  key. If the same message is displayed again, press the  Esc  key.

Q The following messages are displayed.

• “Remove disks or other medias. Press any key to restart.”

• “Non-System disk or disk error. Replace and press any key when ready.”

• “Invalid system disk. Replace the disk, and then press any key.”

• “Boot: Couldn't Find NTLDR. Please insert another disk.”

• “Disk I/O error. Replace the disk, and then press any key.”

• “Cannot load DOS, press any key to retry.”

A If your computer has an optional floppy disk drive connected, remove the floppy disk from
the floppy disk drive and press any key.

A Check “Trouble Checklist” provided at the end of this manual and contact Toshiba PC Dial.
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Q  “C:¥>_” is displayed

A The MS-DOS prompt is in full screen display.
Do either of the following:

•  Method 1 - Switching to the MS-DOS prompt window

• Press the  Alt  +  Enter  keys.

•  Method 2 - Exiting the MS-DOS prompt screen

(1) Input  E   X   I   T .

(2) Press the  Enter  key.

Q Other messages are displayed.

A See the manual of the system or application in use.



92

? OTHERS

Q My computer starts in Safe Mode.

A The optional device drivers or applications may have caused problems.
Follow the steps below to check the hard disk.

(1) Click [Start] → [My Computer].

(2) Click the (C:) drive.

(3) Click [File] → [Properties] from the menu bar.

(4) Click the [Check] button for [Error Check] on the [Tools] tab.

(5) Check [Scan defective sectors and recover] on the [Disk Check] window.

(6) Click the [Start] button.
Restart your computer upon completion of the disk check to see if your computer
successfully starts.

If the above operation does not successfully start your computer, contact Toshiba PC Dial.

REFERENCE: See “Help and Support” for information about Safe Mode.

Q My computer makes rattling noises.

A Data is being automatically saved onto the hard disk.
During computer operations, internal jobs such as automatically saving data are performed.
You hear the operating sounds of the hard disk but this is not a problem. If you hear
extremely abnormal noises or find abnormal conditions, contact your sales dealer or the
nearest maintenance service.

Q I hear TV and radio sounds.

A The modular cable may be catching the TV and radio sounds.
If your computer is connected to a telephone outlet with the standard modular cable and an
extension modular cable, use only the standard modular cable and see if it catches the
sounds. To ensure noise-free conditions, attach a noise killer to the modular cable. If this
does not solve the problem, the subscriber line may be catching the noses. Contact your
telephone company.
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Q The TV and the radio nearby my computer do not work properly.

A Do the following:

• Turn the indoor TV and radio antennas in another direction.

• Change the relation of your computer to the TV and the radio.

• Move your computer away from the TV and the radio.

• Use separate power outlets for the TV, radio and your computer.

• Attach a commercially available filter between the power plug and the power outlet.

• Use the outdoor antenna for the receiver.

• Replace the parallel feeder with a coaxial cable.

Q My computer freezes.

A Abort the application with no response.

REFERENCE: For troubleshooting, see “Q: An application freezes.” in “Applications”
described earlier in this section.

If your computer still does not work successfully, take the following action.

A Abort Windows.
Do not abort Windows unless the system freezes. Aborting Windows disables Standby and
Hibernate modes as well as erases unsaved data.

REFERENCE: For troubleshooting, see “Q: Selecting [Turn Off Computer] does not turn off
my computer.” in “Turning On/Of” described earlier in this section.

Q My computer may have been infected by a computer virus.

A Use virus check software to see if a virus is found. If a virus is found, exterminate it.
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Q I noticed an abnormal smell and heat.

A Turn off your computer and the optional devices and disconnect the power plugs from
outlets.
Ensure safety, remove the battery pack from your computer, and then contact your sales
dealer or the nearest maintenance service.
The following information is required:

• Name of the device

• Date of purchase

• Current conditions (as fully as possible)

Q I cannot figure out the cause of inoperability.

A Check “Trouble Checklist” provided at the end of this manual and contact “Toshiba PC
Dial”.

Q I want to dispose of my computer.

A When disposing of your computer, follow the local regulations and rules. For more
information, contact your local government.

REFERENCE: For information on disposal, see “3 About disposal” in Chapter 7.


